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| ntroduction

The XRD Conversion program was developed to convert raw, legacy X-Ray diffraction data
into ausable format, from UDF filesto UDI files. The program consists of two windows:. con-
version and editing. This program allows the conversion of multiple data files.

Document L ayout

This document is broken into five sections. The first two describe how to start the XRD Con-
version program and the main program features. The next three sections describe how to
select filesfor conversion, how to actually convert the files, and how to edit converted or
unconverted files.
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Sarting XRD Conversion

Start the XRD Conversion program by clicking on the XRD icon, or by opening it from the
Sart Menu (Explorer Window).

The first window to appear is the main conversion window (See Figure 1).

E}. XRD Converzion Program Hi=]
Eile Edit “iew

innnmnveriod Fiag

........

ronveriesd Fieg

Figure 1. The Main Conversion Window.
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XRD Conversion Main Window

Important Features

* Thereisamenu bar at the top of the window. The three menu lists provide accessto
all available program functions.

* The top dialog box, “Unconverted Files”, will display the unconverted (raw data)
files selected from a specified folder(s). This box does not become active until files
have been added.

* The bottom dialog box, “Converted Files”, will display the files after they are con-
verted. This box becomes active when the converted files are displayed.

* Thetwo buttons at the bottom of the window allow you to begin a conversion, or
exit the XRD Conversion program completely.

* Clicking on the green XRD box next to the title opens a list of options. These
options allow you to move, size, minimize, maximize, or close the screen.

The Menu bar

The menu bar contains three menu lists—File, Edit, and View (See Below).
File Edit View

Selecting a Fuction

You canselect a function in one of three way4) Select an option from one of the three lists
by clicking on it with the mouse. OR) Next to the function on the menu list, a control key
command is given. Hit th€trl key + the key of the underlined letter in the function name
(e.g. to activate “Select Files” hold dowtr1+S). OR(3) Hit the Alt key + the letter button

that is underlined in a function to activate that particular function (e.g. to active “Select Files”
click onAlt+S).

Options Under “File”
» Select Files— this option allows you to select raw data files for conversion. Choose
the files using the “Raw Data Files” dialog box that appears upon option selection.
(See "Selecting Files for Conversion" p. 4).
e Sart Conversion — this option starts the conversion once the appropriate files are

loaded into the “Unconverted Files” box. Performs the same function Ssthe
Conversion button located at the bottom of the window. After the conversion is
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complete, the program opens an alert box displaying the number of files converted.

* EXxit — this option exits th¥RD Conversion program completely. Performs the
same function as tHexit button.

Options Under “Edit”

* DeleteFile — this option performs different actions, depending on where the file is
located. For unconverted fileis deletes the selected file from the “Unconverted
File” box and the XRD program. It doBKOT delete the raw data from the original
file! For converted filesit deletes the selected file from the “Converted File” box
and also from the folder to which it is sent after converditve.converted fileis
completely deleted, but the raw data still existsin itsoriginal folder.

Options Under “View”

* Open File - this option allows you to select a file and open it for editing. This
selection will open the “Edit Text File” window with either the raw data or the con-
verted data, depending on which file you selectm this window you can edit
any of the data available (See "Editing Files" p. 7).

Selecting Filesfor Conversion

Downloading Data

Before any file can be selected for conversion, the data files must be downloaded to your
local machine. Be sure to place them in a location that is easily identifiable by anyone who
will use the conversion program.

Selecting the Files

1. From the main Conversion window, cho&sbect Files from theFile menu. This
opens the “Raw Data Files” dialog box (See Figure 2).
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Figure 2. Select filesfrom t

his dialog box.

2. If you know the directory address, enter it in the Directory History box. If not, use the
L ook in: box to navigate through the directory tree until you find the files you need.

3. Add the raw data files to the “Selected Files” box by either double clicking on a file, or

by first highlighting the file, then pressing tAeld button.

4. Remove a file at any time by highlighting it and clicking Reenove button for one

file, or Remove All to remove all files displayed.

5. Once all the raw data files you want to be converted are listed, cliCkthHmitton.
The files are exported to the XRD “Unconverted Files” box on the main window. They

are now ready for co
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Converting Files

Your files should now be listed in the “Unconverted Files” box on the main conversion win-
dow (See Figure 3).

‘Unconverted Files:

oMM T Probileshistephens Personals D atah 1 1054828- 244/59-50 PCS

Figure 3. Unconverted files ready for conversion.

NOTE: Once your files are listed in the “Unconverted Files”
box, do NOT leave this screen until you have converted your
files. If you leave this screen to select more files from the
“Raw Data Files” dialog box, the files already listed will be
deleted. Make sure you always convert the files listed before
trying to import more files into the “Unconverted Files”

box.

1. Start the conversion in one of three ways: (1) select Start Conversionfrom the File
menu, (2) click on the Start Conversion button at the bottom of the screen, (3) or
pressthe Ctrl+T keys.

2. After the conversion is complete, you will receive a message indicating the number of
files converted (See Figure 4).

i Conversion Complete

Figure 4. Message indicating number of files converted.

3. Click on OK to see the converted file(s) listed in the “Converted Files” box.

4. Theconverted filesare saved in the same directory wheretheraw datafilesare
located. The converted fileislisted with a UDI extension (e.g. 1105a001.udi).
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Editing Files

Both the unconverted and converted files can be accessed for editing.

Opening aFile
1. From the main conversion window, highlight the file you want to edit. It can be an
unconverted or a converted file.
From the View menu, select Open File. This opens the “Edit Text File” window.

An unconverted file, once opened, should look similar to Figure 5.

& E dit Text File
File

Sampleldent  ~S5000118209, .~
Titlel . Ocean Drilling Program — Leg 179, .7
Titlez PC-AFPD Sof tware Version 3.6f, 7
DiffrType,PW1710, 7

DiffrHumaer .1, -

Anode, Cu, -~

Labdadlpasl, 1.540G6. .~

Labdailpaad, 1.54439 7

FatioAlpaazl, 0.50000,.
DivergenceSlit . Automatic, 12,7
Feceivingslit. 0.2, 7
MonochronatorlU=zed, YES |~
CeneratorVoltage, 40, ~

TubeCurrent . 35,7

FileDateTime, 5-Maw-1993 0:16..
DataingleRange, 2.0000, 70.0000,

ScanStepSize., n.o0z20,~

ScanType, STER, ~

ScanStepTine, 1.00,-

EawScan
23 12 20 13, 14 22 21 14
18 17 15 12, 17 25 10 21
23 24 26 16, 22 15 145 21
23 18 22 17, 18 7 1z 14
15 22 13 18, 19 213 14 14
21 19 15 20, 17 15 24 1
21 J1 19 22, 20 24 20 1¢
20 19 25 19, 23 21 16 23
a1 18 10 12, 18 16 26 2
28 18 25 20, 26 26 119 15

Figure 5. An unconverted file in “Edit” mode.

4. A converted file, once opened, should look similar to Figure 6. Noticethat thedatais
now sorted into labeled columns.

Ocean Drilling Program
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FE Edit Text File

File

Sample identification: ™~SS0001.8209
Diffractometer type: PW1710 BASED
Tube anode: Cu
Generator ten=sion [LV]: 40
Gen=rator current: 35
Wavelength Alphal [ ]: 1.54056
Waw=zlength AlphaZ: 1.54439
Inten=ity RBatio (alphaZ-alphal): 0.50000
Divergence =lit: Automat-c
[rradiat=zd length [mm]: 12
Feceiwving =lit: 0.2
Honozhromator used: YES

Start angle [0Z2e]: 2.0000
End angle [02=]: 70.0000
Step =si1ze [0Z2=]: 0.020
Maximum intensity: 834 .0000
Tim= pexr =step [=]: 1.00
Tvpe of =can: STEP
In-en=sities converted to: FIXED

Hinimum peall tip width: 0.0o0
Haximum peall tip width: 1.00
FP=al. ba=e width: 2.00
Minimum =ignificance: 0.75
Humber of peaks: 175

Angle d-wvaluse d-wvalue Peal width Peak int Back. int Eel. int Signif.

[@2&] &1 [ 1 &2 [ 1] [@2&] [count=] [counts] [#]

3,200  27.5872 276558 0.1e0 5 3 0.e n.az

4. 040 21,8529 21.9073 0.040 11 9 1.2 0.9a

L.780 15,2777 15,3157 0.040 13 22 1.6 1.17

6,260 13,8857 13, 9202 0.z2e0 9 31 1.1 1.42
20 13 2219 0040 21 31 2 5 1 08

g 2 13 2549
Figure 6. A converted file in “Edit” mode.

5. Edit the data as you deem necessary.

The “File” Menu
Click on Filein the corner of the editing window to display itslist of options (See Figure 7).

Open File Crl+0
LCloze File Cirl+C

Save File Cirl+5
Save b Chr et
E xit Chrl

Figure 7. File menu options
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Open File
This option allows you to open text files in “edit” mode. Clicking on this option opens the

“Text Files” dialog box (See Figure 8). From this box you can select the file you want to open
in the “Edit Text File” window.

Text Files [ 7]
Directory -
Hizton: | LA ﬂ
Look jn: | I [
__|bbw | Orawin
__| heapagnt | Prograrm Files
__|kpocms __IRecucler
__|Md _ATemp
__[0dp __'winnt
__| Orant

File name: = udi | Load |
“udi j Cancel |
Figure 8. The “Text Files” dialog box.

Files of tupe:

Close File
This option closes the currently opened file in the editing window.

Save File

This option allows you to save the editing changes. Use the “Save File” dialog box to select
the appropriate folder (See Figure Bhis does not show text files opened within the text
edit window. It only displaysfiles opened in the conver sion window.

Save As

This option allows you to save your edited file as a new file, or in another location. Selecting
this option brings up the “Save File” dialog box (See Figure 9).

Ocean Drilling Program
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Save File

Directory )
Hiztony: | LA

Save in: | — C:]

| btw | Orawmin

__| heazagnt | Program Files
__| K.pcms __| Recycler
__MNd _ATerp
__0dr __'winnt

__| Orant

File name: Save

“udi ﬂ Cancel

Save a: upe:

Figure 9. The “Save File” dialog box.

Exit
This option closes the editing window and re-opens the main conversion window.

Ocean Drilling Program
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AppendiXx. | nstallation and Setup

The files required for program installation and delivery are located on the “Appsdev” server.
From this server, the files are located in two places: the “Develop” and the “Deliver”
directories. Use the directory to which you have access

Deliver Directory

1. The three installation files in the “Deliver” directory are located at
V:\Deliver\Apps\XRD\XRD_Conv.

2. The three files in the XRD_Conv folder required for installation step.exe,
Xrd.001, andXrd.002.

3. Copy these three files.

Create a “Temp” folder on your local hard driRPaste the three files into the “Temp”
folder.

5. Go to thestart menu and click oRun.
Find the “Setup” executable and run the setup.

7. While the setup is running, a dialog box will appear. The box informs you that the files
are being placed on your local hard driv€aODP\XRD.

8. Click on theFinish button.

9. A window with theXRD Convert andUninstall Executable will open.Copy the
XRD Convert.

10. Go to the desktop. Right click the mouse and sPkste from the menu displayed.
This creates an icon for the XRD program on your desktop.

Develop Directory

1. The three installation files in the “Develop” directory are located at
V:\Develop\XRD_Conv\Exe.

2. All remaining steps are identical to the installation from the “Deliver” directory. Once
the three installation files are located, start at step #2 from above.

Ocean Drilling Program
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